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Input data
Data
Electron diffraction data were measured on a transmission electron microscope JEOL JEM2100-Lab6 (hybrid pixel detector from ASI, 200 kV acceleration voltage, λ = 0.02508 Å).
164 frames, each covering a goniometer rotation of Δα = 0.3558°, exposure time = 0.3 s
Every 20th frame was recorded with a defocus to check for the crystal position.
Input files
Folder "tiff": contains measured diffraction patterns in TIF format
Folder "refinements": reference Jana files of all refinement stages
Folder "reference_cif_pets": reference PETS output files for structure determination
Folder "reference_data_reduction": full set of reference data reduction files
glycine.pts as input file to PETS2:
lambda 0.025080
# wavelength
geometry continuous
# diffraction geometry: continuous-rotation
omega 230
# orientation of goniometer axis
phi 0.18000
# semi-angle of the covered angular range Δα of one frame
virtualframes 7 5 1
# The idea of virtual frames is to assure that the dynamical calculation of rocking curves avoids
that incomplete or partial intensities are determined. Only fully integrated intensities should
contribute to the refinement. 7 frames a (virtually) combined to form one virtual frame. Two
subsequent virtual frames have an offset of 5 frames.
aperpixel 0.005340
noiseparameters 2.5000

1.0000

center 234.87 233.17
beamstop no
dstarmax 1.800
dstarmaxps 2.0
i/sigma 7.00 5.00
reflectionsize 8.0
# The concept of virtual frames is described in Klar et al. (2021) submitted
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PART 1 - Data reduction in PETS2
1. Peak search
Start PETS2.0 by double clicking the executable
Main menu bar: "File"→"Open"
Open the file glycine.pts
Open the "Parameters" menu by clicking on the arrow ("v")
All important parameters are already set in the input file.
Click the action button “Peak search”.
The progress can be followed in the "Image data" panel.
In the console, for each frame the estimated position of the primary beam, the number of
Friedel pairs and the number of significant peaks is given. If you cannot see the console, activate
View → Panels → Console. The process ends with the following message in the console:
Minimum, average and maximum position of the primary beam:
234.76 236.09 236.64 |
232.07 233.23 236.64
Finished reading
3457 peaks from the file glycine.rpl.

2. Rotation axis and peak analysis
Click on the action button “Rotation axis”
In the “Cylindric projection” panel, a cylindrical projection of
the difference space of the extracted peak positions is
displayed. A correct azimuthal angle refinement results in the
image containing sharp peaks aligned on sinusoidal curves.
This step provides a first estimation of data quality. The refined
omega angle is 230.391 degrees.
Click the action button “Peak analysis”.
Click “Peak analysis (continue)”
Click “Peak analysis (continue)”

3. Find unit cell and orientation matrix
Click “Find unit cell and orientation matrix”
Click on “Find possible cells automatically”
A triclinic unit cell is found with α and β close to 90 degrees, and γ = 68.051°. PETS did not
suggest a monoclinic unit cell because the tolerance settings are too tight.
Increase “tolerance for angles” to 2 degrees
Click on “Find possible cells automatically”
Now the found unit cell corresponds to a
standard setting with β > 90°.
However, α-glycine is usually described in a cell with a ≈ 5 Å,
b = 11.4 Å, c = 5.4 Å.
Open the "Modify cell" menu by clicking on the arrow ("v")
Define the following transformation matrix:
a*' = c*, b*' = -b*, c*' = a*
And Click “Transform by matrix”
Go back to the indexing menu and
Click “Refine Cell”

Leave the indexing panel by clicking “Finish”

4. Integrate intensities
In the options of "Process frames for integration" accessible by clicking one of the side-arrows
of the action button, increase RC width to 0.004 (rec. Å) and the apparent mosaicity to 0.25
(degrees).
Click “process frames for integration”
We will assume an extremely broad rocking curve to make sure that reflections are integrated
on all frames and later adapt the profile parameters.

The expected profile (red) is too broad. We first look at the lowest-resolution shell at the
bottom. Reflections at this resolution are hardly affected by the mosaicity and thus are suitable
to estimate the RC width.
Reduce the RC width to 0.003 and hit Enter.
The red curve is updated, but still too broad.
Reduce the RC width to 0.002 and hit Enter.

The red curve is still too broad.
Reduce the RC width to 0.0016 and hit Enter.
The red curve is still too broad.
Reduce the RC width to 0.0012 and hit Enter.
The red curve now looks better. Looking at the higher-resolution shells, the red curve is still
slightly too broad, indicating that the mosaicity is a bit less than 0.25 degrees.
Reduce the apparent mosaicity to 0.23 and hit Enter.
The red curves of the higher resolution shells are still too broad.
Reduce the apparent mosaicity to 0.21 and hit Enter.
The fit is now OK (see below).

Click "Finalize integration" keeping all the parameters by default.
In the console, a list appears with Rint(obs)/Rint(all), the number of observed over all reflections
and the redundancy is given for each Laue class. Glycine structure belongs to the 2/m Laue
class. At this stage you should obtain the values shown below: Rint(obs)/Rint(all) = 11.30/11.33
for 600/724 reflections.

This last step is a prerequisite to optimize the frame orientation using the option “integrated
intensities”.

5. Optimize frame orientation
Open the "Optimize geometry and integration parameters" menu by clicking on the arrow ("v")
Uncheck the checkbox "refinement using rocking curve profile"
Check the checkbox "refinement using frame simulation"
Check the checkboxes "orientation angles" and "center of the diffraction patterns"
Uncheck all other checkboxes
Select the radio button "integrated intensity"
Click "Optimize geometry and integration parameters"

The frame orientation (alpha-tilt, beta-tilt and omega angle) and DP centers are optimized.
You can evaluate the success and the progess of this optimization by looking at the following
curves in the Graph tab:
-Tilt corrections: with Δalpha and Δbeta-tilt frame by frame. You should see a trend.
-Origin corrections: corrections applied on x and y coordinates of the center frame by frame.
Open the "Find unit cell and orientation matrix" menu by clicking on the arrow ("v")
At the top "Data used for indexing": select "cor"
Click "Refine cell"
This refined the orientation matrix taking the new frame orientations into account.

Click "Finish"

6. Remove suspicious frames
We only want to use reflections from frames that were properly measured.
Go to the "Image data" panel
Select radio button "processed"
At the bottom menu activate "si" to see the integration masks
Set the "Display cut off" to 10

Set the "Frame" to 1, i.e. 1 of 159
We can clearly see that on Frame 1/159 the bottom has a dark area with ~0 counts suggesting
that something, probably a part of the TEM grid, blocked the electron path between the sample
and the detector in this area. Though a part of the frame, it is easier to remove the complete
frame.
Set the "Frame" to 2, i.e. 2 of 159
The not-illuminated area has moved a bit downwards, but still a significant fraction of the
detector was not illuminated and thus the reflection intensities are not properly determined in
this area. The same holds for frames 3, 4, 5, 6 and 7. On Frame 8 the bottom left corner shows
still shadow, but the area is very small.
Open the "Frame dialog" In the "Image options" tab
Mark frames 1 to 7 (using the SHIFT key and the mouse or up/down keys)
Deactivate the checkbox "use for calculation"
OK
In the "Image data" panel set the "Frame" to the last frame, i.e. 159/159
Again we observe a region at the bottom left that seems to be not illuminated. This shadow is
even easier to detect if you set the "Display cut off" to 5. The shadow can be seen already on
frame 148 and 149, and gradually grows until the last frame. A non-negligible effect may be
expected on frames 154, 155, 156, 157, 158 and 159.
Open the "Frame dialog" In the "Image options"
Mark frames 154 to 159
Deactivate the checkbox "use for calculation"
OK
Run again "Process frames for integration"

7. Generate output file for structure determination
In the "Finalize integration" options, check the checkbox "kinematical"
Select the radio button "fit profile" as mode of intensity estimation
Activate the checkbox "frame scaling" with Laue class "2/m"
Interframe correlation range: 8
Interframe correlation weight: 0.4
Activate the checkbox "dynamical" with virtual frame settings:
number of frames: 7
step between frames: 5
Click on “Finalize integration”

These stats confirm the point group 2/m.
Two output files (apart from the log files) are generated:
glycine.cif_pets is the list of reflections for structure solution and kinematical refinement.
glycine_dyn.cif_pets is the list of reflections for dynamical refinement.
Click on “File” → "Save"
The state of the data reduction is saved in the folder "reference_data_reduction"
Close PETS2.0

PART 2 – Structure solution and kinematical refinement
1. Create new structure
Important! The data-processing procedure is almost never perfectly reproducible. Small
differences in the indexing and cell refinement procedure may result in small differences of
integrated intensities. If you want to be sure that you can reproduce the following part of the
tutorial, it is recommended to use the file "glycine.cif_pets" in the folder "reference_cif_pets"
provided with the tutorial files. Using your own cif_pets file is also possible, but your results may
slightly differ from the results described in this tutorial.
Start Jana2020
Main menu bar: "Structure" → "New"
Enter “glycine” as filename; “open”

2. Import Wizard
The data import is automatically started.
[On the screen: Specify type of the file to be imported]
Select “known diffractometer formats”; NEXT
Select "Pets electron diffractometer"
Make sure that "Make the reflection file for dynamical refinement" is NOT checked
"Browse" for the file glycine.cif_pets; “Open”; NEXT

[On the screen: Complete/correct experimental parameters]
The unit cell parameters, radiation type and wavelength are correctly set. The sample was
measured at T = 100 K. The temperature has no effect on the structure solution or refinement.
NEXT
[On the screen: Define the reference cell]
We do not want to change anything.
NEXT
1204 input reflections were properly handled.

OK
[On the screen: Define parameters for absorption and scaling procedure]
NEXT
The import wizard is complete. As a next step you can import another or
modify the previously imported ones.

FINISH; OK

3. Symmetry wizard
The symmetry wizard starts automatically after the import wizard. You may alternatively start
the symmetry Wizard by expanding “Reflection file” in the Command tree. There, double click on
“Make space group test”.
NEXT
"Maximal deviation for cell angles in degs": 1.5
Uncheck "Search for higher symmetrical supercell"
NEXT;
If the monoclinic point group is not shown it means that in the previous step the allowed
deviations were too strict.
Select the point group “2/m”; NEXT
[On the screen: Select cell centering]
We assume a primitive unit cell.
Select the radio button “P”
NEXT
[On the screen: Select space group]

The space group should be selected on the basis of the analysis of reciprocal space. You may do
so in PETS2.0 with the option "Reciprocal-space sections". From the reciprocal-space sections,
we could derive the space group P21/n. Space group determination is not part of this tutorial.
Choose the space group “P21/n”; NEXT
[On the screen: Final step of space group test]
“accept the space group transformed into the original cell”; FINISH
[On the screen: Processing refinement reflection file for Block1]
In the next step the reflection file is generated from the hkl input file taking the determined
symmetry into account.
NEXT;
944/1204 reflections read from input file
918/1122 reflections written to output file

OK; OK;
(At the bottom) "Sigma(I(ave)) from": select "Equivalents"
PETS provides uncertainties based on detector and counting statistics. Due to the systematic
errors introduced by the kinematical approximation, it is often advantageous to determine the
standard uncertainties from reflection intensity statistics.
NEXT
Summary after averaging
Rint(obs/all) = 7.68/8.98 for 478/630 reflections …

OK; FINISH;
OK to start the structure solution wizard

4. Structure solution
The structure solution setup windows opens automatically after the space
group determination. You may alternatively start the structure solution by
expanding “Structure solution” in the Command tree. There, double click on “Rund Superflip”.
Enter the chemical formula: C2 H5 N O2
Formula units: 4
Activate “Use local normalization”
Iteration scheme: CF
Starting model: Random phases
For peak search use: EDMA – fixed composition

“Run superflip”
The structure is solved by superflip.
OK
“Draw structure”
"View along": b
Show atom labels:
Klick on the red “X” to close JanaDraw
“Accept last solution”

Open JanaDraw
Possibly, like in the shown picture, atom types were not correctly assigned. The
oxygen atoms should be bonded to a carbon (sp3) atom, and the terminating C1
atom is nitrogen.
To correct the atom types:
Click the quick button “Edit atoms” on the left part of the main window
Double click C1 atom

Select correct "Atomic type"; N
Select the second atom to change (N1) with “select atom(s)
from list”
Select N1; OK;
Change the atom type and select “C”
OK
The atom types are corrected, but not the labels.
Click "Select all" to select all atoms of the list
Click "Action" -> "Rename atoms - atom_type+number"
OK; YES
Now the structure should look like the one shown below.

[ KIN_4+solution is the current state of the Jana files. You may use those files for comparison or
use them for the subsequent kinematical refinement. ]

5. Kinematical refinement
Right-click the quick button “refinement” (on the left panel) to acess
the “Refinement commands” window
Uncheck the checkbox "Refinement on F(obs)**2"
OK; YES+START
The refinement converges with R(obs) = 22.53% and wR(all)= 29.32 %
Click JanaDraw
Right-click the carbon atom C2 (which is bonded to another C atom and the nitrogen atom) ->
"Adding hydrogen atoms – automatically"; OK;
"Run refinement"
The refinement converges with wR(all)= 32.52
[ glycine_1+refinementH is the current state of the Jana files ]
The structure is not charge balanced yet and three hydrogen sites must be identified. One C-O
distance is a bit shorter. If there is a hydroxyl group, there must be 2 hydrogens bonded to the
terminal N1. It is well known that the hydrogen of OH of glycine molecules in the solid state
migrate to the nitrogen atom, so that the terminating nitrogen is part of (NH3)+

In JanaDraw, click on N1 so that only this atom is selected
Right-click the terminal N1 -> "Adding hydrogen atoms – interactively"; OK;
By default, Jana expects N to be bonded to one non-H neighbor (C2) and two hydrogen sites
Click "Locate positions in map"
The difference Fourier map shows the nitrogen site (red) and the two calculated hydrogen sites
(green). The map only fits well to the calculated hydrogen site on the right, but not so well to
the site on the left.

Close the Fourier map by clicking the red X
[On the screen: Adding "hydrogen" atoms for "N1"]
Select the radio button "Tetrahedral"
Click "Locate positions in map"
The difference Fourier map shows the nitrogen site (red) and the 3 calculated hydrogen sites
(green). This map fits much better to the expected hydrogen coordinates. The bottom left H site
is a bit shifted, but given that it is a kinematical refinement based on one (rather incomplete)
data set, this match is very good and confirms the (expected) (NH3)+ terminal group.

Close the Fourier map by clicking the red X
[On the screen: Adding "hydrogen" atoms for "N1"]

APPLY
Constraints were automatically written. You can see them by opening the M50 file with an
editor or in Refinement -> Refinement commands -> Restraints/Constraints -> Keep commands
Run refinement
The refinement converges with wRall= 25.10
[ KIN_5+refinementAllH is the current state of the Jana files ]
With the left CTRL key pressed, select all C, N and O atoms
Right click on one of the atoms -> Define/Edit atom parameters
ADP parameter(s): "harmonic (anisotropic)"; OK;
At the bottom menu of JanaDraw click on "Draw Ellipsoids" button
"Run refinement"
The ADPs are not acceptable.
Edit Structure parameters -> Edit extinction parameters (double click)
Select radio button "SHELX model"
Check "EXTI"; OK; YES
Run refinement
The refinement converges with wR(all)= 19.97%.
The ADPs are now physically allowed as all ADP tensors are positive definite, but their shapes do
not look as if they correctly represented the thermal motion of the atoms. This problem can be
partly "solved" by removing the worst fitting reflections using the "Skip reflections" option in
"Select/Listing" of the "Refinement commands". However, the resulting ADPs are still not
reliable and should not be considered representative.
[ KIN_5+ADP+EXTI is the final (kinematical) state of the Jana files. ]
In the top menu bar: "Structure" → "Save as"
File name: "gylcine_dyn"; SAVE
[ On screen: Do you want to continue with the new structure? ]
YES

6. Data import for dynamical refinement
Expand "Reflection file" -> "Import/modify reflection file" (double click)
Click "Delete"; OK;
"Reflection file" -> "Import/modify reflection file" (double click)

Select "Single crystal": "known diffractometer formats"; NEXT
Select "Pets electron diffractometer"
Click "Browse"; Locate "glycine_dyn.cif_pets"; OPEN

Check "Make the reflection file for dynamical refinement"; NEXT
[On the screen: Complete/correct experimental parameters]
You may set the Temperature to 100 (Kelvin). This has no influence on the refinement.
NEXT; NEXT;
All 2986 input reflections were properly handled

OK; NEXT; FINISH; OK
[On the screen: Processing refinement reflection file for: Block1…]
Note that "Make the reflection file for dynamical refinement" is checked.
NEXT;
2315/2986 reflections read from input file …

OK; OK; FINISH

7. Dynamical refinement setup
In the command tree (left), expand “Edit structure parameters” → “Edit parameters for
electron diffraction” (double click)
[On the screen: many options starting with orientation matrix]
In the top section on the left:
Set “Maximal diffraction vector g(max)” to 1.8
This g(max) is related to the resolution of the dynamical calculations, which should in general be
a bit higher than the resolution of the highest reflections used in the refinement.
Set “RSg(max)” to 0.7
Set “DSg(min)” to 0.0015 (Å-1)
RSg(max) and DSg(min) filter out reflections for which an incomplete or unreliable rocking curve
integration is expected, e.g. reflections that lie on or are close to the goniometer rotation axis.
Set “Number of threads” to the number of physical cores of your processor
In the top section on the right:
Set “Number of integration steps” to 38
Set “Geometry” to “rotation”
In the section in the middle:
"Select zones for refinement"
Unselect zones 1, 2, 4, 8, 12, 16, 20, 24, 28, 31 (using the CTRL key + mouse click)

These are the virtual frames of which at least one frame was deactivated during the data
reduction.
“except of scale, optimize also”: check “Thickness”
Click “Run optimizations”

The dependence of R factors of individual virtual frames on the thickness is determined. The
initial thickness estimation is necessary to get a stable starting point for the dynamical
refinement and to avoid getting stuck in a local minimum.
Click "Show thickness plots"
You can look at the dependence of the R factor on the thickness for the different frames. The
best R factors are typically found with a thickness of about 400
Å or in the range 200 to 600 Å.
Close the plot (red X)
Click on “Select zones for editing”; “Select all”; OK.
The EDThick box is yellow and locked because the parameter is
not the same for all selected zones.
Click EDThick box; click Unlock and change the value to 400.
This changes EDThick for all zones to 400 Å.
Click on “Select zones for editing”; “Refresh”; OK
By changing number of zone by “Zone#” textbox, we can see that all zones have EDThick 400 Å
Uncheck the checkbox “Thickness”
Click on “Run optimizations”
This will optimize the scale factor for each frame based on a thickness of 400 Å.
OK; YES to save m42 file.
[ DYN_7+setup is the current state of the Jana files. ]

8. Dynamical refinement
"Edit structure parameters" -> "Edit extinction parameters"
Select radio button "None"; OK; YES
Make sure that you are in JanaDraw mode to follow the structural changes after each
refinement cycle.
"Refinement" -> Refinement commands
Check for convergence: stop if 0.5 in 1 consecutive cycles.
Deactivate "Refinements on F(obs)**2
OK; YES+START
The refinement converges with wR(all) of 11.11%.
[ DYN_8+refine is the current state of the Jana files. ]

9. Optimize frame orientation
In the Command tree, expand "Edit structure parameters "
"Edit parameters for electron diffraction" (double click)
Check "Orientation" and then "Run optimizations"

This will slightly adapt the orientation of the frames.
OK; YES
Run refinement
Refinement converges to R(obs) 8.46% and wR(all) 10.42%.
[ DYN_9+orientation_opt is the current state of the Jana files.]

10.Refinement without constraints
In the Command tree, expand "Refinement "
"Refinement commands" (double click) -> Restraints/Constraints
Click "Keep commands";
"Refresh"; "Select all"; "Disable"; OK;
Note that the button "Keep commands" is now labelled "Keep commands[0+4!]", indicating that
there are 0 active "keep" commands and 4 disabled "keep" commands.
OK; YES+START
Refinement converges to R(obs) 7.75% and wR(all) 9.69%.
ADP ellipsoids have a meaningful shape and the freely refined hydrogen coordinates maintain
the expected geometry.
[ DYN_10+final_free is the current state of the Jana files.]
For comparison, you may also try an unconstrained kinematical refinement as continuation of
step 5. Or you may try to locate the hydrogen sites from the difference Fourier map in a
dynamical refinement after removing the hydrogen sites.

